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Section 1: Working with Imported Geometry 

 

In industry today, CAD models of solid geometry are used 

commonly to design parts and assemblies and create their 

corresponding drawings for the manufacture of said parts. 

Analysis of these parts and assemblies, however, is still often 

done by hand without the aid of a finite element analysis (FEA) 

package. The advantage of using FEA for multiphysics analysis is 

that simplifying assumptions do not have to be made, and thus 

more efficient, lighter parts can be designed. FEA can also 

provide insights into many analysis questions that cannot be 

measured with hand calculations, such as overall deflection, 

fatigue life, and natural resonant frequency of a complex part or 

assembly. FEA is a powerful tool that is becoming more and more 

valuable in industry, but many potential users hesitate to try it, 

because they are unsure of how to prepare their CAD geometry 

for importation or how to properly configure their CAD model for 

analysis.  

This section covers the eight key topics a user needs to 

successfully import their CAD geometry into an FEA multiphysics 

software package, such as Autodesk Simulation Multiphysics, and 

it assumes that the user has experience in a CAD solid modeling 

software. It begins with an overview of what types of CAD files 

can be imported and software tools that can make importation 

easier. This is followed by an explanation of how to edit CAD geometry as needed to reduce 

the time required for analysis or to study multiple scenarios. Then, specific details of a 

successful analysis are covered, such as how to deal with assemblies, assigning various 

material properties, and optimizing results through mesh refinement. Throughout the topics, 

common pitfalls will be covered, and these will be summarized again at the end of this 

section. 
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1.  Module 1: Importing Geometry from Autodesk and 

Non-Native Applications 
 

Introduction 

For this module, the user needs to have a CAD file they wish to analyze. Provided with this 

module are several versions of a yoke part, specifically a Pro/Engineer, Solidworks, Autodesk 

Inventor, IGES, and STEP version of the same geometry. In the video demonstration, two 

versions are used, Solidworks and Inventor, which were chosen to illustrate how identical 

geometry will look different when imported into Autodesk Simulation Multiphysics or other 

FEA software packages, depending on the CAD software in which it was created.  

For the analysis, the Autodesk Inventor Fusion CAD file will be imported directly into 

Autodesk Simulation Multiphysics. For this first module, the 

CAD files will not be edited, and topics that will be covered in 

more detail later will simply be mentioned as a topic for later 

discussion.  As such, the video will proceed in a step-by-step 

manner, showing all the steps necessary to prepare a CAD 

model for analysis, including importing the geometry, applying 

the loads and boundary conditions, choosing a material, and 

generating a mesh. 

Any anomalies between the various software tools will be 

discussed to help address issues that might hamper a novice 

user. 

Execution 

The purpose of the video is to demonstrate how a CAD model 

can be imported into Autodesk Simulation Multiphysics directly. 

Two different CAD files of the same yoke geometry will be 

imported, specifically a SolidWorks version and an Autodesk 

Inventor version. Differences between the orientation of the 

geometry, etc. will be discussed. Then, the Inventor Fusion 

version of the yoke part will be imported into Autodesk 

Simulation Multiphysics. Loads and boundary conditions will be 

applied to the yoke, its material will be defined, its element type 

will be defined, and it will be meshed using default settings.  

1. To begin, open Autodesk Simulation Multiphysics and you 

will be prompted to select a file to open. 

2. From the "Files of type" toolbar, select the appropriate CAD file type. Only CAD software 

installed on your computer will show in this toolbar. For this example, choose Autodesk 

Inventor Fusion part. Note, the video will also open the Inventor and the SolidWorks parts to 

show how the orientation will be different depending on the CAD package.  

3. Browse to the correct directory, and open the Yoke_Inventor_presplit.Section1.Module1 

file. This will cause Inventor Fusion to open in the background because of how the file was 

Files of type 

Only CAD software loaded on your 

computer or produced by Autodesk 

will show as an option for "Files of 

type.”  If you do not own the CAD 

software, you need to use Inventor 

Fusion or have the CAD file 

converted to IGES or STEP. 

CAD geometry orientation 

CAD software naming conventions 

vary. In Inventor, the X-Y plane is 

"Top"; whereas in SolidWorks, the X-

Y plane is "Front". When imported 

into Autodesk Simulation 

Multiphysics, the geometry 

orientation will vary, but this is 

unimportant. 
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made. Note that the yoke part is oriented with the X-Y plane labeled as "Top". This varies 

with CAD software package. During import, you may be prompted with other questions, such 

as what type of analysis you would like to perform and whether or not to import the CAD 

model's material properties. Accept the default, "Static Stress with Linear Material Models", 

and it doesn't matter if you import the material or not. The default model color for the first part 

is green in Autodesk Simulation Multiphysics. 

4. Almost every command within Autodesk Simulation Multiphysics can be controlled with a 

right mouse button click. Hover over the menu tree on the left by "Element type" and click the 

right mouse button. Select "Brick". 

5. Hover over "Material" in the menu tree and click the right mouse button. Select "Edit 

Material...", then "Steel", "AISI", and "AISI 1020 Steel, cold rolled" and select "OK". If asked, 

say "Yes" to replace the material, which is imported with the CAD geometry from some CAD 

systems. 

6. Double check your system of units. Hover over "Unit Systems" in the menu tree and click 

the right mouse button to select "New". If the units are not "English (in)", click in this menu 

space to get a pull-down menu to select "English (in)." 

7.  In the top menu, select the "Mesh" tab and click "Generate 3D Mesh". Select "No" to not 

view mesh results at this time. 

 

2.  Module 2: Editing Non-Native Imported Geometry 
 

Introduction 

For this module, the user needs to have a CAD file they wish to analyze. Provided with this 

module are the yoke parts described above. The goal is to demonstrate how a part may need 

to be edited prior to performing an analysis. Two of the common issues with CAD models 

imported into an FEA software are small features and incorrect split planes. Small features, 

such as tiny holes or recesses, fillets, and chamfers, cause the model to be meshed at a 

much higher density than is necessary. This slows down the analysis and can cause meshing 

problems. However, some small features are critically important and need to be left in, so it is 

important to know when small features can be safely eliminated. For instance, a tiny hole in a 

flat plate creates what is known as a stress concentration, and the smaller the hole, the more 

likely the hole will behave like a crack. A corner fillet is often essential to reduce a stress 

concentration in the corner for the same reason. FEA, therefore, becomes a useful analysis 

tool to determine the minimum size a hole or fillet can be for the desired stress level in the 

part. If it is desirable, these features can be deleted or suppressed in the original CAD model 

or within the FEA package. Also, Autodesk Inventor Fusion provides a quick and easy way to 

delete undesired features or alter the size of a feature. 

CAD models divide holes into two half circle surfaces, and the designer has no control over 

where this split plane occurs. About half the time, the split plane is ninety degrees out of 

phase for the desired loading direction on the hole surface. Thus, the user needs to correct 
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this split plane by either editing it in the original CAD package or 

by using another method. Inventor Fusion provides a quick and 

easy way to alter the split plane, and the user does not need to 

have access to the CAD software in which the model was 

originally created. 

Editing is also often necessary during the design optimization 

process. The size of a feature, its location, its necessity, or 

even its quantity may need to be modified several times until 

the best part is produced. In most CAD packages, the part has 

a history, so modifying a feature requires knowledge of how it 

was built and the dependencies that may exist between 

features. With Inventor Fusion, a history-free direct modeler, 

these restrictions are eliminated. As a design iteration tool, this 

makes Inventor Fusion an extremely powerful tool. 

The video will demonstrate how to edit the yoke part, changing 

its split plane on the circular holes.  

Execution 

1.   To begin, open Autodesk Simulation Multiphysics and open the 

Yoke_inventor.Section1.Module2 part. Accept the default linear model type. You will need to 

select "Files of type" from the startup menu to choose "Autodesk Inventor" in order to see the 

file. 

2.   In the top menu, select the "Selection" tab and click "Surfaces". 

3.   Hover mouse over the interior surface of one of the holes in the yoke part. Note that it is 

divided into two surfaces and turns the mesh yellow as your mouse passes across the 

surface. The surface is split top to bottom instead of left to right, which is incorrect if we want 

to apply the load along the X-axis. 

4.   Open Autodesk Inventor Fusion and open the Yoke_inventor.Section1.Module2 part. 

5.   To rotate part, hold down the Shift key while holding down the middle mouse button. 

Select "Axis" from the top menu and then select the inside surface of the first hole. Repeat for 

the second hole, so that an axis appears in both holes. 

6.   In the top menu, select the small arrow to the right of "Plane" and select "Plane at Angle". 

Then, pick one of the axes you just created and type in 90 degrees. Repeat for the second 

hole. 

7.   In the top menu is a region labeled "Solid" and within that is a command called "Split" that 

looks like a block with a jagged red line through it. Hovering your mouse over the icon will 

confirm it is the "Split" command. Select this command, and a pop-up menu appears. 

8.   Pick the "Target Face" as the inside surface of the hole. Pick the "Split Tool" as the plane 

you created. Select "OK" in the pop-up menu. Repeat for the other hole. Notice that a line 

now appears in your hole. In Autodesk Simulation Multiphysics, the surface will retain its 

original top to bottom split, but will now have another split left to right. 

Note about Autodesk Simulation 

Multiphysics and .fem files 

Autodesk Simulation Multiphysics 

always saves a .fem file that has the 

same name as your CAD file. If you 

make a serious mistake and want to 

start from scratch, it helps to rename 

the CAD file first, as this will trigger 

Autodesk Simulation Multiphysics to 

make a new file with no history 

associated with it. 
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9.   Note: The following steps to delete features are NOT shown in the video, but are provided 

as reference. To delete unwanted features, you can click on the features one-by-one and 

right click to pull up a menu to select "Delete." Also, in the top menu to the far right in the 

"Manage" region is a command called "Simplify". In the left menu tree, click on the icon next 

to the name of the part, Yoke_inventor.Section1.Module2. This will highlight the model in 

blue. Then click on "Simplify". 

10.  In the pop-up menu that appears, there are three types of features, fillets, chamfers, and 

holes. Entire features can be deleted by type, or by type with a range of sizes. Make sure 

only fillets are checked and from the bottom of the menu, select "Delete". 

11.  Accept this as done by clicking on the tiny checkmark in the upper right of the pop-up 

menu. Note that you may have to relocate this pop-up menu in order to see the checkmark. 

12.  Continuing with the video, click on "Autodesk Simulation", and your edited model 

appears in Autodesk Simulation Multiphysics. Note that dragging the cursor over the surfaces 

of the hole now displays four quadrants of a circle. Select one of the hole surfaces pointing 

away from the geometry, then hold down the Ctrl key and select the other quadrant hole 

surface pointing away from the geometry. Release the Ctrl key. 

13.  When both surfaces are highlighted purple, right click and a pop-up menu will appear. 

Select "Add" and then select "Surfaces forces...".  

14.  Another pop-up menu appears, select the "X" radio button and type in -1000 for the 

number of pounds to apply in the minus X direction. Select "OK". Green arrows appear on the 

hole in the direction of the applied load. 

15.  Hover mouse over the interior surface of the smaller hole, rotating the model with the 

middle mouse button as necessary. Select the two surfaces facing away from the yoke 

geometry, using the Ctrl key. Right click on the screen and select "Add" and then select 

"Surface boundary condition." Selected "Fixed" and then "OK". Triangles will appear on the 

hole to indicate they are fully fixed in space. Partial boundary fixation is indicated by circles. 

This model is now ready to run the analysis. Note that you can return to Inventor Fusion at 

any time to make additional edits, and none of your loads or boundary conditions will be 

affected. They remain as they were. 

It is also possible to make edits in the original CAD software in which the part was made, but 

this requires the user to have the same version of the software as the person making the 

part. It also requires the user to know how to use that CAD software and how revisions are 

made in a part with several dependencies between features. 
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3.  Module 3: Importing Parameters from CAD Models 
 

Introduction 

In this module, we will discuss how to import preliminary FEA results from a CAD package 

into Autodesk Simulation Multiphysics for more detailed analyses. Although it is possible to 

do all of your analysis work and simulation within Autodesk Simulation Multiphysics, often this 

work is split between two different people. Finite element analysis, however, often reveals 

stress concentrations, overdesign, or other aspects of a design that are suboptimal. Thus, it 

makes sense for the CAD designer to iterate on their design within the CAD software until it is 

as optimized as possible. Fortunately, most CAD packages now include FEA software for this 

purpose. These FEA tools are typically rudimentary and are not intended to replace more 

robust FEA software, but they are quick and easy to use and provide the CAD designer with 

valuable information. 

As it is valuable to retain work done by the CAD designer, Autodesk provides an interface 

between Autodesk Inventor and Autodesk Simulation Multiphysics that imports loads, 

boundary conditions, meshing configuration, and contacts.  This key advantage increases 

efficiency and eliminates duplication of effort, as much of the preliminary model setup is 

already completed upon opening the CAD model within Autodesk Simulation Multiphysics. 

Also, the CAD model has already undergone some optimization, so less analysis iterations 

will be needed. 

The video will begin with opening a CAD model within Autodesk Inventor. Loads and 

boundary conditions will be applied, and the model will be simulated within Inventor. It will 

then be imported into Autodesk Simulation Multiphysics for further analysis, illustrating what 

information transfers and how the meshing can be revised after import. 

It is worth noting that most CAD packages use a tetrahedral meshing algorithm rather than 

brick meshing, as it is much easier to do. Tetrahedrons only have four sides and four nodes, 

so they do not resolve to the final stress values as quickly or robustly as brick elements with 

six sides and eight nodes. 

Execution 

1.   To begin, open Autodesk Inventor and open the file 

Yoke_inventor_without_loads.Section1.Module3. This yoke model has had the surfaces of 

the holes presplit. If you do not own Inventor, a second file has been prepared for Part B of 

the video that contains all the loads and boundary conditions, and this demonstration can 

resume from step 10 below. 

2.   We will assume that we would like to do a preliminary FEA simulation in Inventor. Select 

the "Environments" tab from the top menu bar and then choose "Stress Analysis." Next, 

select "Create Simulation" and accept all the defaults from the pop-up menu with "OK". 



Section 1: Working with Imported Geometry 

3.   "Stress Analysis" will have a menu similar to that found in Autodesk Simulation 

Multiphysics, listing Material, Constraints, Loads, and Contacts. Right mouse click on 

"Material" and choose "Assign Material". 

4.   In the pop-up menu that appears, click on "Override 

Material" and choose "Stainless Steel 440 C". Select "OK" 

and close this menu. 

5.   Right mouse click on "Constraints" and select "Fixed 

Constraints". Select the interior surface of the smaller hole 

that is facing away from the geometry. Select "OK" and close 

this menu. Note: To confirm that the boundary condition was 

applied, expand the "+" symbol in the left menu tree for 

"Constraints", and drag your mouse across the listed 

constraint. The surface will highlight. 

6.   Right mouse click on "Loads" and select "Add Force 

Load". If you were to select the interior surface of the larger 

hole now, it would place a force normal to the cylinder 

wherever your mouse landed. So, expand the pop-up menu 

using the "<<" button. Then checkmark the box to "Use vector 

components" and type in -1000 lb in the Fx vector direction. 

Then pick the interior surface of the larger hole on the side 

facing away from the geometry and select "OK". 

7.   From the top menu, select "Simulate" and then click 

"Run". A color gradated, displaced model will appear on the 

screen. 

8.   Select "Finish Stress Analysis" from the top right menu. 

9.   Save your Inventor model under a new name. If you skipped these steps, you will locate 

the Yoke_inventor_with_loads.Section1.Module3, and continue with that model. 

10.  There are two ways to open your model in Autodesk Simulation Multiphysics. As you 

may have skipped steps 1-9, we will use the second way. To open your model from within 

Inventor, you could select "Add-Ins" and then "Start Simulation." Instead, we will open 

Autodesk Simulation Multiphysics and open either your saved model or 

Yoke_inventor_with_loads.Section1.Module3. 

11.  In the pop-up menu that appears, uncheck the box for the non-simulation version of the 

CAD model and checkmark the box next to "Simulation1". Also uncheck the box for including 

midside nodes, as the meshing is going to be discarded later. 

12.  You will note that several parameters are imported, including you loads and boundary 

conditions, your material selection, and the element type (currently Tetrahedral). Contact 

types will also import for assemblies. 

13.  Right click on "Element Type" and change it to "Brick".  

Applying Parameters in Autodesk 

Inventor 

Like Autodesk Simulation 

Multiphysics, Inventor has at least 

two ways to perform every 

command. Common "Constraints" 

and "Loads" are also available for 

selection directly from the top menu 

bar. 

Element type change is not 

automatic 

After changing your element type to 

brick elements in Autodesk 

Simulation Multiphysics, it will still 

produce a tetrahedral mesh until the 

3D Mesh Settings are updated to be 

all brick. 
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14.  Although we have now defined the model as brick elements, nothing has changed. If you 

go to the "Mesh" tab at the top of the screen and select "Generate 3D Mesh", you will see 

that the meshing is tetrahedral. 

15.  To force the meshing to be brick elements, go to the "Mesh" tab at the top of the screen 

and select "3D Mesh Settings". 

16.  In the pop-up menu that appears, select "Options", then select "Solid" from the icons on 

the left of the pop-up. This will bring up another menu and will show that the file imported as 

"All Tetrahedra". Select "All Brick" instead and select "OK" twice.  

17.  From the main pop-up menu (or from the main menu of Autodesk Simulation 

Multiphysics), select "Mesh model." You can also close the pop-up menu and select 

"Generate 3D Mesh." Either way, the part will be meshed as bricks now. This concludes the 

analysis on this part. 

18.  Edits on the CAD model can be made within Autodesk Simulation Multiphysics, if the 

CAD model was made using Autodesk Inventor. Under "Mesh", there is a tab in the top menu 

bar that says "Inventor Parameters." Selecting on this will open a table with all the features 

contained in the CAD model. Any value can by overridden and changed. This will update the 

CAD model within Autodesk Simulation Multiphysics only. However, results can be pushed 

back into the CAD model if desired. 

19.  Finally, contact types created within Dynamic Simulation, part of Autodesk Inventor, will 

import into Autodesk Simulation Multiphysics if set within Inventor. Dynamic Simulation is 

covered in another Section, not here. 

 

4.  Module 4: Contact Types for Simulation 
 

Introduction 

When working with an assembly, it is important to define how the various components will 

interact with one another. A shaft may rotate in a hole, a surface may slide against another 

surface, or two plates may be essentially bonded together by a bolt. Autodesk Simulation 

Multiphysics offers many options for how two surfaces should interact. 

 Bonded—This is the default contact between two parts, wherever surfaces are in 

contact. It behave as if the two parts are glued together, like they are made from one 

piece of material. For example, use this for bolts clamping plates together, where the 

coefficient of friction is very high and the pieces will not move relative to one another. 

 

 Surface—When bonded is inappropriate, a surface contact is often used. This allows 

two surfaces to freely move away from another under loading conditions, but they 

cannot move towards or through each other. A shaft in a hole is an example of where 

a surface contact might be used. Friction might also be turned on to better simulate 

actual conditions. 
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 Welded—This contact type is convenient for welded structures, where the outer 

edges of two parts are bonded, but the interior edges are not, such as shown below: 

 

 

 

 Free/No Contact—This means that the two parts do not interact with one another. 

No loads are transferred from one part to the other, even if they come in contact. 

 

 Sliding/No Separation—This contact type allows two surfaces to slide freely past 

each other, but they are not allowed to gap as the loading is applied.  

 

 Separation/No sliding—This is the opposite of the above, where the coefficient of 

friction is extremely high, so loads applied to the parts will cause them to separate, 

but not slide along one another. The differences between these two cases is 

illustrated below: 

 

 Edge—This contact type is much like welded, but can be used along any edge for 

any length.  

 

 Create Contacts Between Parts—This is a feature that automatically creates 

contact pairs between parts. It is best to define contact surfaces based on knowledge 

of the design than to rely on defaults used for automatic contact pairs. 

 

 Settings—Under settings, friction can be turned on, and the coefficient of friction can 

be set. This is also where the tolerance angle between two surfaces being “in 

contact” is set. 
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Execution 

1.   To begin, open Autodesk Simulation Multiphysics and open the 

Yoke_assembly_step.Section1.Module4 assembly. 

2.   In the left menu, select the yoke part and then hold down the Ctrl key and select the large 

pin part. 

3.    Right click with the mouse and select, "Contacts". 

4.    From the pull-down menu, select "Surface" for the contact type. 

5.    At the bottom of the left menu tree, a text box will open to allow you to name this contact 

pair. Name it "yoke to large pin" and then Enter key. 

6.    Repeat for the small pin, and name it "yoke to small pin". 

7.    To define a coefficient of friction, from within the "Contacts" menu, select "Settings". Turn 

on friction by checking the box, and then set the desired coefficient in the text box. 

The behavior of the assembly during simulation will depend entirely on the contact types. The 

default contact type is bonded, which will make the assembly behave as a single component, 

like a lump mass. It is important to think about how the various components behave relative 

to one another prior to running the simulation, or the results will be inaccurate. 

 

5.  Module 5: Defining Materials and Properties 
 

Introduction 

Most modern CAD software is capable of defining materials and properties, but these choices 

are very limited, and usually, they cannot be significantly edited. FEA software, on the other 

hand, has always had an extensive selection of materials, and Autodesk Simulation 

Multiphysics comes with all of these libraries loaded by default. Thus, hundreds of materials 

can be selected from the library, but also any material can be created from scratch or created 

by modifying an existing material. Although it is possible to create laminates and other 

composite materials, that is beyond the scope of this demonstration. 

For this module, any CAD model can be used, including an assembly made up of several 

different materials. For the video, an assembly made from three SolidWorks parts will be 

used, but it will be edited within Autodesk Inventor Fusion so that the user does not need to 

own any particular CAD software to follow the demonstration. 

Execution 

1.   To begin, open Autodesk Inventor Fusion and open the 

Yoke_assembly_solidworks.Section1.Module5 assembly. 
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2.   In the left menu tree, click on the Yoke_solidworks.Section1.Module5 part, and it will 

highlight in blue. 

3.   In the top menu, select the "View" tab and from the far right, select "Material." You have 

the option of setting the physical or visual material properties, and there is a pull-down menu 

to select a different material. Select "Stainless steel" from the menu, then close the material 

selection by clicking on the small "X" icon. 

4.   In the top menu, select the "Home" tab and then select "Autodesk Simulation" to import 

the assembly into Autodesk Simulation Multiphysics.  

5.   Within Autodesk Simulation Multiphysics, the assembly will appear in three colors, the 

yoke in green, the large pin in red, and the small pin in yellow. These defaults are set by 

Autodesk Simulation Multiphysics. 

6.   In order to change the materials of the parts, it is first necessary to define the element 

types. Click on the "Element type" from the left menu tree for "part 1", then hold down the Ctrl 

key and select the "Element type" for "part 2" and "part 3". 

7.   Right mouse click and select "Brick" for the element type. 

8.   Looking at the left menu tree (Note: the menu tree area can be expanded by dragging the 

window to the right), the materials are listed as "stainless steel" for the yoke, and "alloy steel" 

for the two pins. This is because we altered the material for the yoke in Inventor Fusion, while 

allowing the two pins to be the default material. Click on the "alloy steel" for one of the pins, 

then hold down the Ctrl key and select the "alloy steel" for the other pin. Right click and "Edit 

material". 

9.  Note that the default material properties for alloy steel are loaded in as default values. 

These values can be edited by selecting "Edit properties" from the bottom left of the pop-up 

menu. 

10.  To change the units from SI to US Customary, cancel out of the material selection menu 

and from the left menu tree, select "Unit Systems" and right click to select "New." 

11.  In the unit system pop-up window, select the window that says "English (in)" and reselect 

"English (in)". Return to editing the material properties, and the alloy steel will now be written 

in US Customary units. 

12.  To choose a material from the library to replace the alloy steel, expand the menus on the 

left and browse to find an appropriate material, such as Stainless Steel AISI 430. 

13.  Library material properties can be edited to reflect actual material data, or library 

materials can be used as a template to define a custom material. To edit a material, select 

"Edit properties" from the lower left. 

14.  Alter values as desired. If you change your mind, select "Reload from library". 

One of the pitfalls a beginner might encounter is trying to find an anisotropic material, such as 

wood. It will not be loaded in the material library until after the material properties have been 

defined as anisotropic. This will be covered in the next module. 
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6.  Module 6: Isotropic vs. Anisotropic Materials 
 

Introduction 

Sometimes, the material that we want to analyze has material 

properties that differ with material orientation. These materials 

are known as anisotropic materials, and they have their unique 

challenges for finite element analysis.  The most common 

anisotropic material is wood, which has high strength along 

the main tree axis, and much lesser strength in the two radial, 

orthogonal directions. Other materials that are anisotropic 

include composites, polymers, and materials with a crystalline 

structure, like silicon. Since the properties vary with material 

direction, it becomes necessary to define this direction for the 

component. Autodesk Simulation Multiphysics has a complete 

library of wood materials that are accessible once the material 

has been defined as orthotropic, where orthotropic is a special 

subset of anisotropic materials with three orthogonal directional properties. 

Execution 

The video will demonstrate how to define the yoke assembly as being made from three wood 

components, including how to define the global axis for the direction of highest stiffness. 

 1.  To begin, open Autodesk Simulation Multiphysics and you 

will be prompted to select a file to open. 

2.  From the "Files of type" toolbar, select the appropriate CAD 

file type. Only CAD software installed on your computer will 

show in this toolbar. For this example, choose SolidWorks 

assemby. Note, the assembly can also be opened in Autodesk 

Inventor Fusion, if you do not have SolidWorks. 

3.  Browse to the correct directory, and open the 

Yoke_assembly_solidworks.Section1.Module6 assembly file. 

This will bring the assembly into Autodesk Simulation 

Multiphysics as three components. 

4.  In the main left menu tree, nothing should be defined for 

any of the three components. If it is, start over with an assembly that has been renamed 

outside of ASM. 

5.  As in previous modules, define the element type as brick, create surface contacts between 

the pins and the yoke, and mesh the part. 

6.  Using the Ctrl key, select the "Element Definition" for all three components, then right 

mouse click to "Edit.." 

7.  From the "Material Model" pull down menu, choose "Orthotropic" then click "OK". 

File names and .fem files 

When reusing parts and assemblies 

during this section, remember that 

Autodesk Simulation Multiphysics 

creates a .fem file, which has a 

memory. To avoid this, rename your 

parts and assemblies to get a fresh 

.fem file for each module. 

Autodesk Simulation Multiphysics 

Material Libraries 

Like right mouse clicks and other 

menu selections, ASM's material 

libraries are context dependent. 

Orthotropic materials are only shown 

if the element is defined as 

orthotropic first. 
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8.  From the main left menu tree, use the Ctrl key and select the "Material" for all three 

components, then right mouse click to "Edit Material..." 

9.  Now, the only material choice will be "Wood" 

10.  Select "Birch, yellow" for the material and close the menu 

11.  Although all the components are now made of yellow birch, we still need to define the 

orientation for the wood grain. For the yoke, right mouse click on the "Element definition" and 

"Edit..." 

12.  Select the "Orthotropic" tab from the tabs at the top, and ensure that the "Global X 

Direction" is selected. Repeat steps 11 and 12 for the pins, changing them to the "Global Y 

Direction" 

13.  As in prior modules, apply your loads and boundary conditions. Note that since the 

material is now wood instead of steel, the applied force needs to be small. I used -10 pounds 

in the X direction. A higher force of even -50 pounds will cause the model to fail. 

 

7.  Module 7: Principles of Model Meshing for 

Simulation 
 

Introduction 

In this module, we will discuss the principles of model meshing, especially the importance of 

locally refining the mesh to capture peak stresses around stress concentrations. For most 

geometry, the default meshing algorithm within Autodesk Simulation Multiphysics is sufficient 

to analyze the stresses in a component or assembly. However, this is not always the case. If 

the component has small features, complex geometry, thin-walled elements, or stress 

concentrations, the default mesh density will not adequately fill the region, leading to an 

underestimate of both stress and displacement. In addition, choosing a brick element when a 

tetrahedral or plate element would be more appropriate can lead to the brick elements 

becoming highly distorted, which could lead to inaccurate results or the inability of Autodesk 

Simulation Multiphysics to analyze. 

Stress concentrations are small holes, sharp corners, or abrupt changes in size located in 

places of high stress. Around the edges of these features, the stress increases dramatically, 

and can be significantly higher than the stress just fractions of an inch farther away from the 

feature. With a default mesh density, the number of elements around a stress concentration 

are the same as the number of elements anywhere else in the geometry. Thus, only a few 

elements are being used to determine the stress around a feature. To see if the number of 

elements is adequate, it is necessary to locally refine the mesh density. This is done by 

selecting a region of nodes around a potential stress concentration and then adding what are 

known as refinement points. The user then doubles or triples the number of elements around 

the stress concentration and reanalyzes the stress. If the stress doesn't change significantly, 
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then the mesh density is adequate. If it does change, then a third iteration on the mesh 

density around the feature is warranted. 

Different types of elements are best for different types of geometry. Although brick elements 

are preferred for most solids, they are not always the best choice. Brick elements have six 

sides and eight nodes, whereas tetrahedral elements have four sides and four nodes. Thus, 

several tetrahedral elements can fit within the same space as a brick element. For complex 

geometry or small features, this makes tetrahedral elements preferable to brick elements, 

because they conform to the geometry more completely. 

 

 
Example brick and tetrahedral element 

 

In general, it is preferable to use brick elements for your solid geometry, selectively using the 

less robust tetrahedral elements only where needed. The speed of the analysis depends 

upon the number of nodes and elements, so higher order elements are more efficient.  

For cases where the geometry is thin and can be described as having a plate or shell 

thickness, then the model should be reduced to midplane geometry, where the surfaces are 

defined by their thickness. It is also possible to use plate elements, when reducing the 

geometry to midplanes is complicated. 

 
I-beam modeled in SolidWorks and meshed as midplane geometry 

 

The video will use our yoke model, slightly modified to include a small hole across the region 

of maximum stress. For a first iteration, the yoke will simply be loaded as before and the 
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stress analyzed. Then, the nodes and elements around the small hole will be locally refined 

to increase the mesh density. The model will be reanalyzed and the stress results will be 

compared. For completeness, the model mesh will be locally refined a third time to 

demonstrate how the stress value at the small hole reaches steady state with iteration. 

It is worth noting that the overall mesh density could be increased, instead of just around the 

small hole. However, this would quadruple the number of nodes and elements unnecessarily, 

greatly increasing the amount of time required to analyze the part. 

Execution  

1.   To begin, open Autodesk Simulation Multiphysics and 

open the file Yoke_solidworks_hole.Section1.Module7. This 

yoke model has had a small hole added normal to the long 

axis of the yoke's large hole. 

2.   As per previous modules, add a 1000 lb force in the -X 

direction, add a fixed boundary condition to the small hole, 

brick mesh the geometry, and choose a steel material. 

3.  Under the "Analysis" tab, select "Run simulation". 

4.  The resulting stress will be approximately 18-19 ksi, and it 

is highest around the edges of the small hole. 

5.  The chamfers and fillets on the yoke are in areas of low stress, so they are not important 

for the analysis. A savvy user will recognize this in advance and be able to eliminate small 

features like chamfers and fillets to make the meshing more uniform and improve analysis 

efficiency. 

6.  To learn more about the results, select the "Results Inquire" tab from the top menu bar, 

and turn on a "Probe" to explore stress levels with your cursor. To turn off the probe, select it 

again from the menu. 

7.  There is also a "Maximum" probe that can be toggled on and off, which will show that the 

highest stress is at the edge of the small hole. 

8.   To turn off the displaced model, click on "Show displaced" to toggle it off. 

9.  The safety factor is another menu pick that will be available whenever the stress is being 

displayed. The current safety factor will be approximately 2.7, which is sufficient. 

10.  Since the highest stress is at the edge of the hole, we should increase the mesh density 

locally around the hole to see if we are accurately predicting the maximum stress at the small 

hole (which is acting as a stress concentration). 

11.  To return to the model for editing, click on the tab at the top of the left menu tree labeled 

"FEA Editor" 

12.  Rotate the model to an approximate or exact X-Y "Top View". 

Resolution of stress vs. 

displacement 

Even with a very coarse mesh, most 

FEA softwares packages will provide 

an accurate estimate of the 

displacement. Stress, however, can 

take multiple iterations to resolve to 

a final value around stress 

concentrations. 
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13.  From the top menu bar, select the "Selection" tab, then 

select "Vertices" and "Circle Select" options. 

14.  Place the cursor on a node around the small hole and 

drag a circle to enclose a region surrounding the small hole. 

This will highlight all the nodes through the entire thickness of 

the yoke, including both sides of the hole. 

15.  Right mouse click and "Add"--"Refinement points" 

16.  On the pop-up window read the estimated mesh density 

at the bottom of the window. This should be approximately 

.085 inches. Type in .04 for the effective radius and .04 for 

the mesh size and select OK. 

17.  From the top menu bar, select "Mesh" and then "Generate 3D Mesh". Zoom in on the 

region around the small hole and rotate as desired to see that there are now two nodes 

where there used to be one. The refinement points are black. 

18.  To switch to an isometric view, select "View" tab from the top menu bar, then 

"Orientation" and then "Isometric" 

19.  From the "Analysis" tab, select "Run Simulation" and note that the stress at the edge of 

the hole is now approximately 24 ksi. 

20.  Since the stress increased significantly, it is important to run the analysis a third time to 

make sure the refinement done was enough to capture the peak stress. Repeat steps 16-19 

with an effective radius of .03 and a mesh size of .03. 

21.  On the third iteration, the stress at the hole edge is 25 ksi, which is not significantly 

different than before, so the stress has reached its approximate maximum. 

You can also check the displacement and see that the values do not change from iteration to 

iteration and you can confirm that the stress safety factor is still above 2, which is fine. To 

reduce the stress riser at the small hole, you could increase the hole size or move it away 

from the point of highest stress. 

 

8.  Module 8: Common Complications for Finite 

Element Analysis 
 

Introduction 

In this module, we will discuss some of the common complications associated with finite 

element analysis. Most of these complications revolve around converting geometry into 

appropriate finite elements. Most geometry is fine as-is, but certain types of geometry always 

present challenges. One type of geometry that is always an issue is beams. Beams have two 

conditions that make them prone to analysis errors, high aspect ratios and thin-walled 

Selection tools 

Take advantage of the various 

selection tools in Autodesk 

Simulation Multiphysics. You can 

filter to select only vertices or lines 

and capture them in groups with 

rectangular or circular select. 
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elements. A high aspect ratio is where one dimension, such as the cross sectional area, is 

very small relative to the third dimension, such as the beam length. Thin-walled elements are 

geometry that have large size, but one dimension that could be described as a thickness. 

Again, beams have thin webs and flanges in the range of fractions of an inch and lengths that 

measure in feet.  

The third most common complication is contact conditions that change during analysis. This 

occurs when the loading applied to a part brings two components into contact that were 

initially far apart or conversely, tries to separate two components that were initially close 

enough together to be considered bonded. This third complication is easily overcome by 

setting surface contact conditions between parts that will either approach or separate from 

each other. 

As for beams, the video will illustrate how to work with a beam (or other thin-walled, high 

aspect ratio geometry, such as a shaft or pole) that is imported from a CAD package. The 

beam will be analyzed to demonstrate how the displacement is underestimated by Autodesk 

Simulation Multiphysics.  

Then, a beam will be created within Autodesk Simulation Multiphysics, using the software's 

built-in beam design tool to show how Autodesk Simulation Multiphysics can be used to 

analyze a beam quickly and easily using provided beam databases. 

Execution 

1.   To begin, open Autodesk Simulation Multiphysics and open the file 

I_beam_solidworks.Section1.Module8. This beam was created in SolidWorks using a beam 

table for a W12x50 steel beam, where 12 is the approximate depth of the beam in inches, 

and 50 is the weight in pounds per foot.    

2.  We want this beam to be simply supported with a uniform distributed load of 5000 lb in the 

-Y direction. 

3.  As in previous modules, mesh with brick elements. Select the top surface of the flange 

and apply a 5000 lb surface load. Choose the material as ASTM A-36 steel. 

4.  Select one end cross section of the beam and create a simple supported boundary 

condition. This means you will only allow translation in the X direction and rotation about the 

Z axis. Repeat for the other end of the beam, allowing only rotation about the Z axis. 

5.  Run the analysis and note the maximum displacement is about .026 inches at the center 

of the beam. This is extremely low, as we will see by redoing the analysis with the built-in 

beam tool. 

6.  It is also possible to redo the analysis with midplane geometry on the beam. This requires 

going to "Mesh" tab on the top menu bar, then selecting "3D Mesh Options" and then 

selecting "Solid" from the left icons. Under this, you will find an "Options" tab, and "Midplane 

geometry" is one of the options. You may have to reset your options to default for the 

midplane geometry option to be available. Then remesh the beam, and it will be zero 

thickness surface planes instead of solids. 

7.  To create the beam in Autodesk Simulation Multiphysics, start a new session and instead 

of opening a CAD model, start a "New" model. Name it ibeam or something of your choosing. 
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8.  Switch to a front view, with the X-Y coordinate system showing 

9.  From the top menu bar, select "Draw" then "Line" 

10.  Inside the menu that appears, uncheck the box "Use as construction" 

11.  There are three boxes for the three coordinate directions, and we want to draw a line 

from 0,0,0 to 360,0,0. To do this, click in any of the three boxes, and hit Enter key. This starts 

a line at 0,0,0. Then type 360 into the X-direction box and hit Enter key again. Close the 

dialog box with the red x in the upper right. 

12.  To show the full line created, choose "View" and then "Enclose" 

13.  To divide the line into beam elements, select "Draw" and then use the cursor to click on 

the line. This will make available a command in the upper menu bar labeled "Divide". Select 

this and type in 20 to divide the line into 20 segments. 

14.  Under "View" tab, turn on "Endpoint vertices" 

15.  From the left menu tree, right mouse click on "Element type" and select "Beam" 

elements. 

16.  Right mouse click on "Element definition" and in the menu that appears, click in the text 

table somewhere to enable you to click "Cross section libraries" from the lower right. 

17.  Within the libraries window, choose your Section database from the pull-down menu as 

"aisc2005" 

18.  Choose your Section type as "W" 

19.  Start typing w12 in the text box to more quickly locate "W12x50" 

20.  Note that the depth is always in the Y-direction, so you will want to apply loads and/or 

gravity in the Y-direction. Close out of the menus and choose ASTM A-36 steel as your 

material. 

21.  Choose "Selection" from the top menu bar, then "Lines" and "Rectangular select" to drag 

a window around your entire beam. 

22.  Right mouse click and "Add beam distributed load". The load is in pounds per inch, so 

type in -5000/360 to get the correct load. 

23.  Change your "Selection" to vertices and cursor again, and set your boundary conditions 

for both ends of the beam. Right mouse click on the left vertex and check all but Tx and Rz. 

Right mouse click on the right vertex and check all but Rz. 

24.  Run the analysis and you will see that the displacement is now .25 inches, or a factor of 

ten greater than displayed before. Click on "Beam and Truss" icon to find the stress and then 

also check the safety factor, if desired. 

Autodesk Simulation Multiphysics has many ways to perform the same analysis, but the user 

should be aware of built-in utilities that make analysis both faster and more accurate. 

 


